Chapter 1

Getting Acquainted with
Easy Media Creator 8

In This Chapter
Getting familiar with the Roxio Media Creator Home
Overview of the Applications you can launch from Home
A quick look at the Tools you can use at Home

Exploring the Utilities available to you from Home

Frst things first: Before you can use your newly installed Roxio Easy
Media Creator 8 suite to go off and create a copy of your favorite
Coldplay audio CD or to burn a DVD of the family’s most recent outing in the
Adirondacks, you're going to need to know your way around the program. As
you're about to discover, there’s very little that Roxio Easy Media Creator 8
can’t do when it comes to dealing with all the many types of digital media
that are apt to come your way.

Better yet, not only is this baby versatile, but it’s as good as its name. The
Roxio Easy Media Creator 8 suite offers you consistently easy ways to com-
plete all of your media projects — from ripping, arranging, and burning your
own copies of your favorite CDs to finally organizing and tagging those gazil-
lions of digital photos you’ve dumped into nondescript folders all over your
computer’s hard disk.

The only catch (oh, there’s always a catch) is that in order for the Easy Media
Creator 8 to be as multitalented as it is, the good engineers at Sonic Solutions
had to carve the program up into dozens of different little specialized pro-
grams and utilities that taken in at once can be a bit overwhelming (to say
the least). This is where Chapter 1 comes in: Here you not only get a much
needed overview of the many individual and specialized components now at
your fingertips but a good feel for the Roxio Media Creator Home that ties
them all together. Once you get your bearings in this all important hub,
you're ready to see what this program can really do by looking at each of the
individual components.
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Welcome to the Roxio
Media Creator Home

# When you install the Roxio Easy Media Creator 8 suite on your computer’s
“== hard disk, the Windows Installer automatically puts a Roxio Roxio Media
" Creator Home 8 shortcut on the Windows desktop. To open the Roxio Media
Creator Home, you simply locate this shortcut icon (shown in the left margin
of this paragraph) and double-click it.

Figure 1-1 shows the Welcome screen of the Roxio Media Creator Home
window (also known as Easy Media Creator Central) that appears after you
double-click this desktop shortcut. As you can see in this figure, the Welcome
screen of the Home window that forms the hub of the Roxio Easy Media
Creator 8 suite is divided into four distinct areas:

v Menu bar: Contains the four menus, File, Tools, View, and Help, which
you can use to launch and save new media projects, access any of the
Media Creator tools, change the size and appearance of the Home
window, and get help on using Home

v Project List: Lists the categories of projects available in the Easy Media
Creator 8 suite — to expand a category to display a list of all its particu-
lar projects, click the link attached to the category name or click the
tab button to the right of the name (the one with downward-pointing
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v~ Project Window: Displays a list of links for specific tasks or apps associ-
ated with the project you've selected in the Project List pane or, in some
cases, lists the steps necessary to complete a particular task (such as to
back up or copy a disc)

v Control Panel: This area is divided into three sections: the Media
Information Display, which shows a visual representation of the disc or
drive designated as the destination for your project; the Input Area,
which displays a drop-down menu for selecting the recorder to use for
your project, a display showing the recording progress of the project, or
audio and video playback controls; and the Action Area, which displays
an Options button for displaying a list of options associated with your
project, or controls that enable you to start or stop the project.

Note that you can save space in the Roxio Media Creator Home by condens-
ing the Project List pane so that it displays only icons. To do this, click the
Hide Project Pane button or choose View=>Hide Project Pane on the Roxio
Media Creator Home Menu bar. To expand the Project List so that it again dis-
plays both icons and category labels, click the Show Project Pane button (or
choose View=>Show Project Pane).

Figure 1-2 shows the Easy Media Creator 8 Home window after condensing
the Project List pane and selecting the Audio CD project. Note that Project
Window now displays instructions on how to proceed in creating an audio
CD for a typical CD player and that the Action Area now contains a Continue
button that you click after selecting the recorder to use in the Input Area,
inserting the blank CD disc, and adding the audio files to be burned onto the
new CD.

If you have a great need for open space on the Windows desktop (as you might
when dragging and dropping files from open folder windows that you want use
in your current project) you can reduce the entire Easy Media Creator window
to a bare bones minimum. To do this, click the Switch to Mini Mode button or
choose ViewtoMini Mode on the window’s menu bar.

Figure 1-3 shows the Roxio Media Creator Home window shown in Figure 1-2
after clicking the Switch to Mini Mode button. Note that even when the Home
window is in mini mode, you can still go about the business of adding the
audio files for the new CD, while at the same time keeping free most of the
desktop for displaying the contents of other open windows.

To make it easy to open the Roxio Media Creator Home, you can add this
Roxio Easy Media Creator 8 shortcut to the Windows Quick Launch toolbar
by dragging its icon to this bar and dropping it at the place on this toolbar
that immediately follows the Start button on the Windows taskbar.
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If you're like me and are apt to become a really serious user of Easy Media
Creator, you may also want to fix the Roxio Media Creator Home option on
the Windows Start menu (provided that you don’t run Windows in Classic
mode). To do this, you follow these steps:

1. Double-click the Roxio Media Creator HomeS8 shortcut on the desktop.

If you don’t have an Roxio Media Creator Home8 shortcut on your desktop,
you can click the Start button on the Windows taskbar, mouse over the All
Programs option on the Start menu, the Roxio Easy Media Creator 8 option
on the All Programs menu, and then click the Roxio Media Creator Home
option on the Roxio Easy Media Creator 8 submenu.

The Welcome screen of the Roxio Easy Media Creator Home window
shown in Figure 1-1 then opens.

2. Click the Start button on the Windows taskbar to open the Start menu.

The Roxio Media Creator Home option sporting the famous Roxio logo
(a disc with what appears to be a shark fin coming out the top of it) now
appears on the left side of the Windows Start menu.

3. Right-click the Roxio Media Creator Home option to open its shortcut
menu and then click the Pin to Start Menu option on this menu.
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Switch to full mode
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As soon as you click the Pin to Start Menu option, Windows moves the Roxio
Media Creator Home option to the upper area of the left side of the Start
menu (under such Start menu stalwarts as the Internet Explorer and Outlook
Express). If you later decide that you don’t need this option to be a perma-
nent part of the Start menu, you can remove it by right-clicking the option
and then clicking the Unpin from Start Menu option on its shortcut menu.

Attending to the Tasks at Hand

The Most Frequent Tasks links on the right side of the Welcome screen in the
Roxio Media Creator Home window (refer to Figure 1-1) give you immediate
access to many of the most common tasks, such as creating audio CDs, copy-
ing and erasing discs, creating DVDs, and performing file backups. Clicking the
link associated with a particular task temporarily opens the appropriate appli-
cation in the Project Window of the Roxio Creator 8 Home window. The beauty
of the More Frequent Tasks section in the Welcome screen of the Home window
is that you don’t have to give a second thought as to which Easy Media Creator
application to use in order to get done the project you have in mind.

The only problem is that the tasks listed in the Most Frequent Tasks section
represent only the most common disc-related things that you can do with
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Roxio Easy Media Creator 8. Although you can rely on this section for most of
your media backup and data disc projects, be aware that there’s much more
to the Easy Media Creator 8 suite than still pictures. Therefore, you will also
definitely want to become well-acquainted with the additional tasks and tools
offered on the other tabs in the Project List pane.

So Many Apps, So Little Time

As soon as you click the Applications link located immediately beneath
Welcome on the Home tab of the Project List pane in the Roxio Media
Creator Home window, the Project Window name changes to Applications.
The Applications Project Window gives a full listing of all the standalone
applications included in the suite in a column on the left and a bunch of
neat utilities in a column on the right (see Figure 1-4).

The following sections give you a brief introduction to each of the compo-
nents that you can load by clicking its Applications or Utilities link in the
Applications Project Window of the Roxio Media Creator Home. Use this
information to get a quick overview of the capabilities and functions of each
of Roxio Easy Media Creator 8 applications and utilities.
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Would you please Backup MyPC

Backup MyPC is a super utility that enables you to make disc backups of
all the files and folders on your computer. It also gives the ability to restore
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Figure 1-5:
Backup
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these files and folders in case their data becomes corrupted so that you're
no longer able to open them.

In addition to creating these kinds of complete or partial backups of your
data files, you can use Backup MyPC to create a set of disaster recovery discs
that you can use in case of a hard disk failure or crash.

Figure 1-5 shows the Backup MyPC window as it first appears when you
launch this program by clicking the Backup MyPC link in the Applications
Project Window of the Roxio Media Creator Home.
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Playing around with CinePlayer

CinePlayer is a full-fledged DVD player for your computer (one that you may
well end up preferring to the Windows Media Player). You can use this pro-
gram to play all the DVD movies that you create and burn to disc with the
MyDVD program in the Creator 8 suite as well as professionally produced
DVDs that you rent or purchase.

The heart of the CinePlayer is the Sonic CinePlayer Control Panel shown in
Figure 1-6. Note that this panel often disappears behind the CinePlayer window
where the DVD’s video appears as soon you pop the disc you want to play

into your computer’s CD/DVD drive. To re-display CinePlayer Control Panel
when the CinePlayer window is less than full screen, click the Sonic CinePlayer
Control Panel button on the Windows taskbar. When the CinePlayer window is
full-screen, press Alt+Tab until the CinePlayer Control Panel appears on top of
the CinePlayer window.
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When the CinePlayer Control Panel first opens, the side panel containing the
cursor and numeric pad is not displayed. To display this side panel, which you
then can use to select DVD menu items, you need to click the Expand/Collapse
Panel button (the one on the right side with the double vertical bar). If you
don’t display this side panel, you can select items from the menu that is cur-
rently displayed in the CinePlayer window by clicking the item (something
you certainly can’t do when viewing the DVD on a standalone player).

The playback controls on the CinePlayer Control Panel are standard with the
exception of the Jump To button, which when clicked displays a submenu
that enables you go to a particular place in the DVD either by selecting its
chapter (assuming that the DVD uses chapters) or its timecode.

To open a movie that you created with VideoWave (see Chapter 10) or a DVD
project that you created with MyDVD (see Chapter 11), click the Open Disc or
File button and then select either the Browse for File to find the movie file or
the DVD project file on your computer’s hard disk. To edit a DVD project that
you created with MyDVD and burned to disc after viewing it in CinePlayer,
you click the Edit OpenDVD disc (meaning one that to which you have full
editing rights).

If you're viewing a commercially produced DVD that supports subtitles
(either in English or another language such as Spanish), you can display
them in the CinePlayer window. Click the Other DVD Options button, click
the Choose Subpicture option on the pop-up menu, and then select the
language, English (United States) or Spanish (Traditional Sort), on the
Subpicture submenu.

Keep in mind that you can capture key frames (the ones that are clear and
not part of a scene transition) in bitmap graphic files in CinePlayer. Simply
click the Play/Pause button to pause the video at the frame you want to cap-
ture as a still image before you click the Capture Video Frame button. As soon
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as you click this button, CinePlayer captures the image in a bitmap file (indi-
cated by the rather loud click). The first time you save an image from a DVD,
a Browse for Folder dialog box appears, enabling you to designate the folder
and drive where all movie stills are to be saved. This is followed by a Media
Name dialog box in which you can enter a descriptive name (usually the
name of the film you’re watching). CinePlayer then creates the filename for
the bitmap images you capture by appending the descriptive name to the
frame’s timecode.

The comforts of Creator Classic

Creator Classic is the application you use primarily to assemble and burn
your audio and data CDs. The Creator Classic window is divided into four
major areas:

v Projects where you choose between creating a Data Disc (one consisting
only of data files), Multimedia Disc (one that combines data files and
other media such as music or graphics files), or Bootable Disc (one that
contains enough of the Windows operating system that you can use it to
boot from one of your computer’s drives)

v Other Tasks where you can launch programs to make other types of data
discs (CD Extra Disc Creator or Backup Projects), burn a CD or DVD from
an image of the disc stored on one of your computer’s drives (Burn From
Disc Image File), get information and check the status on your computer’s
recorder (Disc and Device Utility), or start the Express Labeler (Make a
Disc Label) to create a label for your CD or DVD

1~ Select Source where you locate and select the files you want to copy to
data or audio CD

v+~ Data Disc Project which displays the name of your disc as well as all the
files you've added for burning onto the CD

Whereas you can use Disc Copier (discussed in the section immediately fol-
lowing) to make a copy of an existing audio or data CD or DVD, you use
Creator Classic to actually put together and burn your data CDs or DVDs. You
use Creator Classic when you want to make backups or archive data files on
your disk. See Chapters 3, 5, and 6 for specific information and examples on
using Creator Classic to assemble and burn audio and data CDs.
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Figure 1-7:
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Copying discs with Disc Copier

As the name says, Disc Copier is the application you use when you need to
make a copy of an unprotected CD or DVD. When you click the Disc Copier link
in the Applications Projects Window in the Roxio Media Creator Home, the pro-
gram opens the window shown in Figure 1-7. Or, [ should say, this window
opens after you dismiss an alert dialog box reminding you that you should use
the Disc Copier component only to make copies of digital media for which you
have the clear legal right to make copies. Knowing that none of you would ever
do anything like that, you can click the Don’t Show Me This Again check box
before you click OK to close this alert dialog box (for once and all).
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You can use Disc Copier to copy an audio or data CD or DVD (usually one
that you've created with Roxio’s MyDVD, since almost every single commer-
cial movie on DVD that you rent or purchase is copy-protected and can’t be
copied with Disc Copier). You can also use it to create a compilation of differ-
ent movies from different sources. As you can see in Figure 1-1, all you need
to do to copy one of these discs is to specify the source and destination
drive. The great thing is, if your situation is like mine and you have only one
CD or DVD drive on your computer system, you can still use Disc Copier to
copy your audio, data, or video discs (see Chapters 3 and 5 for steps with
concrete examples of how you use Disc Copier to copy audio and data CDs).

Lauding the Label Creator

You use the Label Creator link in the Applications Project Window of the
Roxio Media Creator Home to launch the Roxio Label Creator. This applica-
tion enables you to design and print labels for the CD and DVD discs that you
burn with the other Roxio Easy Media Creator applications. The Label
Creator makes quick work of designing both disc labels and the inserts for
their jewel cases. Figure 1-8 shows the Roxio Label Creator window as it first
opens. Note that you open this window not only from Applications Project
Window but also by clicking a Create Label button in the final dialog box
when burning CD and DVD discs (see Chapters 5 and 12 for details).
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The Label Creator window is divided into three panes:

v Add Object with the tools for adding or drawing images that you want to
include in your label project

v~ Edit Layout with tools for selecting one of the ready-made label styles
for your disc label or assigning it a new color or background image or to
automatically add album information in the case of labels for copies of
commercially produced audio CDs

v Layout pane for previewing the contents of your disc label or jewel case
insert (the front and back printed cards that go inside the clear plastic
case that holds the disc), while at the same time enabling you to edit
these contents

For detailed information on using the Roxio Label Creator to design and print
labels for any of your CD or DVD discs, see Chapter 9.

Media Manager at your service

You use the Media Manager to organize the many types of media files (video
clips, still images, audio, and video projects) that you use in the CD and DVD
projects you create. This handy-dandy little program enables you to keep

tabs on particular media files through the use of albums, special Easy Media
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Figure 1-9:
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Creator files that associate selected media files together regardless of where
these files are actually physically located on your computer system. Because
albums reference to the media files you want to associate as a group, you
don’t have to go through all the trouble of copying or moving the files into a
single folder. You can also use the Media Manager to peruse your media files,
tag them with keywords for easy searching, as well as backing these files up
by burning them onto CD or DVD discs.

Figure 1-9 shows the Media Manager window that appears when you launch
the program by clicking the Media Manager link on the Applications Project
Window or the Organize link on the Organize tab of the Project List in the
Roxio Media Creator Home.

Deceptively simple at first glance, this window is made up of only two panes.
On the left, you see a pane named My Media, My Albums, Folders, or My
MediaSpace (UpnP), depending on which type of media container you select.
This pane enables you to select any drive or folder on your system. On the
right, you find a pane with the name of the selected media type, album, drive
or folder that displays all the folders and files within that particular type of
container. You do the rest of the organizing magic with the buttons at both
the top of the Media Manager window and these panes (see Chapter 4 for
details).
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Figure 1-10:
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Audio discs that are music to your ears

You use the new Roxio Easy Media Creator 8 Music Disc Creator to build and
burn audio CDs and DVDs. The music you include in your audio projects can
come from tracks of commercial audio CDs that you've purchased as well as
audio files that you've recorded yourself. Audio discs that you create with
this nifty application can be saved in any of the popular audio file formats
including the standard WMA and the ever popular MP3.

Figure 1-10 shows the Music Disc Creator program window that opens when
you click the Music Disc Creator link in the Applications Project Window of
the Roxio Media Creator Home window. The Music Disc Creator window is
divided into the following panes:

v~ Project Type where you choose between creating a standard audio CD,
MP3/WMA disc, and a DVD music disc

v+ Add to Project where you can add music files to your audio disc project,
including tracks from pre-recorded audio CDs or imported from other
audio CD or DVD discs, as well as record audio files for the project

v Audio CD - Untitled Project which shows the name of your audio pro-
ject along with the tracks in the order in which they will be burned on

the new CD or DVD disc
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Easy multimedia projects
thanks to MyDVD

MyDVD is the application that you use to assemble and burn multimedia pro-
jects on DVD discs. Multimedia projects are those that can combine more
than one type of media, including video clips, still photo images, text, and
audio tracks. You can use MyDVD to quickly and easily convert your digital
home movies into menu-driven productions that you can play on a computer
DVD drive or a standalone DVD player attached to your TV. You can also use
MyDVD to assemble your digital photo collections into slideshows that, when
burned onto a DVD disc, can be played in the selfsame computer DVD drives
or standalone DVD players.

Figure 1-11 shows the program window that first opens after you click the
MyDVD link in the Applications Project Window launch or click the Create
DVD link on the DVD & Video tab in the Project List pane of the Roxio Media
Creator Home window. The MyDVD 8 window, as you can see in Figure 1-13, is
divided into the following four panes:

+* Menu Tasks where you add movies or slideshows you’ve already cre-
ated in the Easy Media Creator 8 suite as menu items or capture and
import video clips, music, or graphics for your DVD project

v~ Edit where you can edit a movie or split it into individual chapters as
well as specify a visual theme for the project’s menu screens (including
layout and labeling of the menu buttons), select a photo or video to use
as the background of all menu screens, or add music or sound effects to
play whenever the project’s menu screens are displayed on the screen

v Project view which visually represents the hierarchy and layout of your
DVD project

v+ Preview which shows you the layout of the menu items and the back-
ground of the main menu of your DVD project and where you can edit
any of the menu titles

MyDVD is possibly the most versatile application in the entire Easy Media
Creator suite. Because you can combine all types of media (video, still
images, text, and audio) as you want, this is the place where you can be really
creative. In no time, you’ll be creating personalized and professional-looking
multimedia projects that you can share with all your friends and family who
have access to either a DVD drive in their computers or a standalone DVD
player. See Chapters 9, 10, and 11 for details on using the MyDVD to create
your own DVD projects.
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Figure 1-11:
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Picture it in PhotoSuite

Photo Suite is the application that you use to organize, edit, and share the
digital photos that you take. You can use this component to enhance the
photos, organize them into albums, use them in creating projects like greet-
ing cards and calendars, as well as easily share them with friends and family.
Figure 1-12 shows you the PhotoSuite window after launching this program
by clicking the PhotoSuite link in the Applications Project Window or the Fix
& Enhance link on the Photo tab in the Project List of the Roxio Media
Creator Home and opening a photo to edit.

As you can see in this figure, the startup window for PhotoSuite is divided
into three panes:

v~ A task pane along the left edge containing a Common tab and an All tab,
both of which are subdivided into Open/Create, Fix, Tools, and Enhance
panes that contain the common options for editing your digital photos
and starting new photo projects

v Canvas pane on the upper right where the photo you’re currently edit-
ing appears

v Open File(s) pane directly below it showing thumbnails of the all the
photos you have open. The Common and All tabs are both.

23
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Note that the Canvas pane on the right side of the PhotoSuite window gives
you general information about the digital photo you’re currently editing,
including its rotation, width, and height. It also contains controls for zooming
in and out on the photo, changing its orientation, saving, printing, and
e-mailing the edited photo. See Chapter 8 for detailed information on using
all the PhotoSuite options.

Getting Secure with Roxio Backup

Roxio Backup enables you to create CD and DVD data file projects that back
up certain folders and files on your computer system. This versatile little tool
not only enables you to make one-time backups of important files but also to
schedule regular backups for important files and to do incremental backups
that include only files modified since your last backup.

Figure 1-13 shows the Roxio Backup window that appears when you first
launch this applet either by clicking the Roxio Backup link in the Applications
Project Window or the File Backup link on the Backup tab in the Project List
pane of the Roxio Media Creator Home. The Roxio Backup window is divided
into three panes:

v Backup Tasks to create a new backup project, refresh the list of files to
be backed up, or to display a report showing the history of backups
made using the current backup project
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Figure 1-13:
Use Backup
to back up
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v Other Tasks to open the Disc and Device Utility where you can select
the device to use in making the backup (usually your CD or DVD drive)
and to launch Express Labeler, a special quick version of the Label
Creator application

v Backup Projects that displays the name of the backup project as well as
the files you want copied as part of the backup
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Saying hello to Sound Editor

You can use the Sound Editor tool to edit or enhance the audio recordings
you make with such tools as Easy Audio Capture and the LP and Tape
Assistant (covered later in this chapter) and convert them to any of the sup-
ported digital audio file formats, including MP3, WAV, OGG, and WMA (see
Chapter 2 to find out what in the world all these acronyms stand for).

Figure 1-14 shows you the Sound Editor window that appears when you
launch this utility by clicking the Sound Editor link in the Applications
Project Window of the Roxio Media Creator Home and after opening an MP3
audio file for editing. As you can see in this figure, the Sound Editor interface
represents the audio file graphically with a sort of waveform readout (remi-
niscent of a snapshot of an oscilloscope display). This waveform displays the
relative amplitude of the sound for the left and right channels (marked L and
R) of the audio file.
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You can then use the controls at the bottom of the Sound Editor to play

back all of or any part of the audio track. You can also use the zoom controls
located immediately above the waveform display to magnify portions of the
audio’s waveform display or zoom out on it so that more of the entire track
is shown in the Sound Editor. See Chapter 5 for details on using the Sound
Editor to edit the audio files that you burn to CD or use in your DVD projects.

Riding the VideoWave

VideoWave is the application that you use to assemble and edit video pro-
jects (referred to in the Roxio documentation as productions) that can include
video clips, still images, and audio. After assembling and editing a production
in VideoWave, you can either add it to a DVD project that you’re making in
MyDVD or use MyDVD to burn it onto a DVD (see “Easy multimedia projects
thanks to MyDVD” that precedes this section).

Figure 1-15 shows you the VideoWave 8 window that appears after launching
the program by clicking the VideoWave link in the Applications Project
Window of the Roxio Media Creator Home and opening an existing slideshow
to edit (you must designate whether to create a new production or edit an



Chapter 1: Getting Acquainted with Easy Media Creator 8 2 7

|
Figure 1-15:
Use
VideoWave
to assemble
video clips,
stillimages,
and audio
into produc-
tions that
you incorpo-
rate into
DVD pro-
jects or burn
directly onto
DVD discs.

existing one as part of the program startup). When you open the VideoWave
8 window to create a new production or edit an existing one, it is divided into
the four major panes shown in this figure:

v Add Content where you add the photos or video clips you want
included in the production as well as select among the various effects
and transitions you want to use

v Tools which includes tools for selecting new media and to include in
the production and effects to apply as well as to launch a CineMagic
Production or New Slideshow built with the Slideshow Assistant
(see description in the bullet list immediately following this one)

1 Preview where you can preview how the your production will play as
you create and edit it

v Production Editor: Storyline displaying a storyboard view of the video
production, showing all the individual video clips and stills with any in-
between transitions in the order in which they will play in the final pro-
duction (this pane can also display the production in a Timeline view
which shows the timing of each element in the production along with
any audio or narration track that you’ve added)
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Personally, I find that VideoWave interface is one of the easiest and most
straightforward for editing video that I've run across. I'm sure that with
just a little experience using this beauty, you're going to love video editing.
If, however, you're a complete newbie to video editing and are the least bit
intimidated about producing your own videos, you’ll be glad to know that
VideoWave includes two new components designed to make video editing
nearly foolproof:

v CineMagic, which automatically edits your video production by trim-
ming your video clips and adjusting the tempo of the audio to fit the
flow and transitions you use (perfect for making MTV-type videos)

v~ Slideshow Assistant, which uses a Wizard-type interface, providing step-
by-step guidance through assembling the various elements in a new
slideshow production including transitions and background music

Starting your video-editing career with CineMagic and the Slideshow Assistant
is a perfect way to become familiar with the VideoWave interface and its capa-
bilities. From there, you can quickly move on to video editing on your own
right using the Storyline and Timeline views. See Chapter 11 for complete
details on using all aspects of VideoWave.

Although you normally launch VideoWave from the Roxio Media Creator
Home, you can also launch VideoWave directly from within the MyDVD appli-
cation when you need to do some advanced editing on a video production
created earlier with VideoWave that you’ve imported into the Video Project
you're currently working on or to do similar editing to the contents of a new
title that you added to DVD project. Suffice it to say that knowing how to use
VideoWave goes a long way in mastering the video end of the Easy Media
Creator suite.

Utilities Perfect for Particular
Media Needs

In addition to all the nifty programs listed in its Applications list, the
Applications Project Window of the Roxio Media Creator Home also inlcudes
a Utilities list that provides the following useful tools:

v Create Panoramas to launch the Panorama Assistant that enables you
to stitch together a sequence of photos into a single panoramic picture
(see Chapter 6 for details)
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v+ DVDInfo Pro to use Roxio DVDInfo Pro to get all sorts of information
about the capacities of your computer’s DVD drive as well as informa-
tion on those of a DVD disc that you want to use in the burning of your
Roxio media projects

v Disc Image Loader to create a virtual drive on your computer into
which you can load disc image files containing audio or video data
culled from different physical discs, thus enabling you to play or to back
up the data without having to do any disc swapping (see Chapter 3 for
details)

v Drag To Disc to copy data and media files onto the CD or DVD disc in
your computer’s CD/DVD drive by simply dragging them to the pro-
gram’s icon (see “Instant data copying thanks to Drag to Disc” in the sec-
tion that follows immediately for details)

v+ Easy Audio Capture for recording audio with your computer’s sound
card either externally using some sort of microphone or internally using
a program such as the Windows Media Player that plays audio on your
computer (see Chapter 7 for details)

1 Media Import to launch Roxio Media Import which enables you to cap-
ture photo, video, and audio clips for your Roxio media projects (see
“The importance of Media Import” later in this chapter for details)

v Multi Photo Enhance for doing group editing on a bunch of digital
photos that all require the same types of fixes and enhancements (see
Chapter 6 for details)

1 Retrieve for recovering data files from a multi-disc CD or DVD data pro-
ject where the data from some files can be split across more than one
disc (see Chapter 3 for details)

Instant data copying thanks
to Drag to Disc

Drag to Disc is one of the neatest yet simplest applications in the Easy Media
Creator suite. You can use this nifty program to make CD or DVD backups or
archives of data files on your hard disk or network simply by dragging their
folder or file icons on the Windows desktop and dropping them on the Drag
to Disc icon (shown in Figure 1-16). The Drag-to-Disc application is great
because it automatically does any formatting for the data CD or DVD as
needed to accommodate the files that you add.
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To display the Drag to Disc icon on your Windows desktop, click the Drag To
Disc link in the Utilities column of the Applications Project area in the Roxio
Media Creator Home window or click the Drag to Disc icon (shown in the left
margin of this paragraph) that appears in the Systems Tray on the right side
of the Windows taskbar immediately to the left of the clock. For details on
making quick data backups and archives with Drag to Disc, see Chapter 3.

Menu
View disc contents
Help

Eject

The importance of Media Import

As the name suggests, you use the Media Import to bring in media files from
various devices such as a digital photo camera, video camera, scanner, and
microphone that’s connected to your computer system. You can also use
Media Import to capture media files from CD or DVD discs (which aren’t copy
protected and to which you have the right to make copies) loaded into the
CD or DVD drive built into your computer.

Figure 1-17 shows the Roxio Media Import window as it appears when I
launch the program by clicking the Media Import link in the Utilities column
of the Applications Project Window in the Roxio Media Creator Home window
and then select the Video tab when my Sony digital video camera is con-
nected to my PC. Your Capture window will undoubtedly differ depending on
the actual devices you have connected to your computer. As you can see, this
window contains the controls for capturing a video clip directly from the con-
nected video camera on the left with a listing of the clips recently imported
on the right. See Chapter 10 for details on using Media Import to capture vari-
ous types of media files for your Roxio Easy Media Creator 8 projects.
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Help Is on the Way!

The best place to go for online help on using any of the nifty applications and
utilities outlined so far in this chapter is the Help menu of the Roxio Media
Creator Home. The Help menu in this window contains the following options:

v Help to open the Roxio Help Center where you can get help on the Roxio
Media Creator Home and doing media projects from it as well as on par-
ticular apps and utilities included in the suite

v~ Tutorial to open a local Web page in your Web browser with links to par-
ticular step-by-step tutorials on topics such as Start a New Project and
Import Photos from Your Camera

v Media Guide to open a local Web page in your Web browser with infor-
mation on the recommended media to use when undertaking a particu-
lar media project such as creating an audio CD, a backup data disc, or a
video DVD

v Gracenote - Your Source for Music Information to connect to the

Internet and open in your Web browser the Home page of the Gracenote
Web site where you can search its enormous online music database
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(consisting of almost 4 million CDs and more than 50 million songs) for
all kinds of information about your favorite artist or track

v Technical Support on the Web to connect to the Internet and open in
your Web browser a Sonic Web page from which you can get technical
tips and seek direct help for any snafus you happen to run into when
running the Roxio Easy Media Creator 8 suite

v+~ Sonic Store to connect to the Internet and open in your Web browser a
Sonic Web page from which you can purchase upgrades to any product
from Sonic Solutions or disc labels to use in your Roxio media projects

v Check for Updates to connect to the Internet and open in your Web
browser a Sonic Web page which checks for and downloads any updates
to your version of the Roxio Easy Media Creator 8 suite

v About This Software to open a window with information about the spe-
cific version of the Roxio Easy Media Creator 8 suite installed on your
computer

Using the Roxio Help Center

Figure 1-18 shows the Roxio Help Center window. As you can see from this
figure, the Roxio Help Center presents its information in a standard Windows
Help window with its Contents, Index, Search, and Favorites tabs in a pane on
the left and the text of the currently selected help topic displayed on the right.
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Note that you can quickly open the Help Center from the Roxio Media Creator
Home window by clicking the Help button (the one with the question mark
immediately beneath Maximize button in the upper-right corner of the Home
window) or by simply pressing F1 when this window is active.

The easiest way to get to general help on the use of any of the suite’s mod-
ules is from the Contents tab. This tab contains a list of Using topics that
comprise all the suite’s modules from Using Roxio Home all the way to Using
Disc Image Loader (with all applications outlined earlier in this chapter in
between). In addition, when you expand the Using Roxio Home topic at the
top of the Contents tab (by clicking the plus-sign button to the immediate left
of its book icon), you find project-specific help subtopics with loads of good
information on making specific types of Audio, Copy, and Data projects.

Getting application-specific help

In addition to the help available in the Roxio Media Creator Home, each of the
indvidual apps included in the suite such as Creator Classic, PhotoSuite,
MyDVD, and the like offer their own application-specific help in two forms:

v~ Help for this Window (the first item on the particular program
window’s Help menu or opened by pressing F1) that acquaints you with
the particular module’s interface

v~ Help Center for the specific module you're using (the second item on
the module’s Help menu) that contains help topics on how to use the
particular module’s features

Figure 1-19 shows you the Help For the Sound Editor window that opens
when you choose Helpr>Help for this Window on the Sound Editor menu bar
or press F1 when the Sound Editor program window is active. As you can see,
this particular help window contains callouts for the Sound Editor window
that enable you to identify its major areas and controls.

Figure 1-20 shows you the Sound Editor Help Center window that opens when
you choose Help=>Sound Editor Help Center on the Sound Editor’s menu bar.
The left pane of this help center is arranged as a standard Windows help
window with its Contents, Index, Search, and Favorites tabs. The right pane
contains a list of links to get general information about Sound Editor and its
basic functions as well as links to online resources.

To get information particular things that Sound Editor can do and specifically
how specific features work, start by perusing the general topics on the
Contents tab. When you find a general topic that might contain information of
interest, click its name or closed-book icon to display a list of links to its
subtopics in the pane on the right. Then, when you locate a subtopic of inter-
est, click its individual link to replace the list in the right pane with a display
of its specific help information.
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You can also expand any of the general help topics in the left pane of the
General tab by clicking the plus-sign button right before the closed-book
icon. When you do this, the closed-book icon becomes an open-book icon
and a list of related subtopics appears under the name of the general one.
To display the help information for any of these subtopics in the right pane
of the Help center, you have only to click its name in the left pane.
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If you know the name of the feature with which you want help, click the Index
tab and then type the first few letters of the feature’s name. The index will
immediately jump to the topics that start with those letters. To display infor-
mation on a particular feature in the right pane of the Help center, click its
feature name in the Index pane on the left.

If you know what you want to do in a particular application or tool but don’t
know the name of the feature that is used in accomplishing the task, you
might find the Search tab to be of more help. After clicking the Search tab

in the left pane of the Help Center window, type in the word or phrase that
describes the task you want to accomplish and then press Enter or click the
List Topics button to begin the search. The Help Center then displays all the
topics that contain the word or phrase you just searched for. To display a
particular help topic in the right pane of the Help Center window, double-
click its name or click it and then click the Display button.

If in your searches you come across a particularly useful help topic to which
you are likely to refer on more than one occasion, you can mark the topic as a
favorite and then display its information again quickly by selecting it from the
Favorites tab. To do this, after you've located the really useful topic on the
Contents, Index, or Search and have displayed its information in the right
pane of the Help Center window, click the Favorites tab and then click the
Add button at the bottom of the left pane (this button appears right below
the name of the displayed topic in the Current Topic text box).

After adding a topic to the Favorites tab, you can redisplay its help informa-
tion by selecting the tab and then either double-clicking it name in the Topics
list box or clicking its name followed by the Display button.

To print a copy of the help topic displayed in the right pane of the Help
Center window, click the Print button on the very first toolbar displayed at
the top of the Help Center window and then click OK in the Print dialog box.
To copy the displayed help topic or step-by-step instructions into a docu-
ment in another Windows program, drag through the text in the right pane

of the Help Center window with the I-beam pointer to select all the text you
want to copy. Then press Ctrl+C to copy the selected text to the Windows
Clipboard, switch to the document in the other program, click the insertion
point at the place where you want the help text copied, and then press Ctrl+V
to insert the help text into the document at the insertion point.
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